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SportingPulse is known as the expert in providing innovative technology solutions that make 
managing sporting organisations easier. Sportzware Central is an offline competition 

management program that is available to the Touch Football community. It enables affiliates to 
easily manage fixtures, results and ladders from a computer desktop. The program also lets you 
manage club, team and member data and to publish that information to your website, saving time 

and duplication. This document outlines in detail specific functions that are available within the 
program and how to use them effectively.
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Part 1 (Chapter 1): Introduction to Sportzware Central 
 
1.1 Installing Sportzware Central & Creating your database 
 
For installation instructions, go to the below link 
http://www.support.sportingpulse.com/index.php/Sportzware_Central_Installation 
 
1.2 The Sportzware Central Startup Wizard 
 
On completion of the Sportzware Central installation, the ‘Sportzware Central Startup Wizard’ 
appears.  You can view and change any database settings through the Configuration tab in that 
database.  

 
1.3 The Data Manager 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The ‘File’ menu 
provides you 
with access to 
the database 
management 
functions (add a 
new database, 
remove a 
database, 
backup your 
database 
etc)…. 

Your databases 
(also known as 
‘data locations’) 
are listed in the 
main box of the 
Data Manager. 

The location of your database on 
your hard drive, and backup details 
are shown here. 
 

The ‘Help’ button will open up the 
Data Manager User Guide. It is a 
good idea to read through this 
PDF document when you get a 
chance. 
 

The ‘Launch’ button will load the 
Navigation Centre with the 
database that you have selected. 
 

http://www.support.sportingpulse.com/index.php/Sportzware_Central_Installation
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The Data Manager is the very first screen that you encounter when you load Sportzware Central.  
It’s primary purpose is to help you manage your Sportzware Central data as efficiently as 
possible.  From the Data Manager, you can perform the following functions: 

 Create a new database 

 Find out exactly where your database is located on your hard disk 

 Backup your database 

 Restore an old database 

 Compact your database to save disk space 

 Send your database to the SportingPulse Technical Support Team if you are 
experiencing problems 

 Upgrade your version of Sportzware Central 

 And the most common function, select which database you would like to launch and use 
 
Multiple Databases 
You may not have a need for more than one database, as each Sportzware Central database will 
manage all of your League’s data for as long as it exists.  If you do want to manage more than 
one database, you should first consider that the two databases will not be linked in any way.   
 
1.4  Sportzware Central Registration 
 
Your Sportzware Central registration code will allow you to use Sportzware Central.  You are 
required to enter a registration key for Sportzware Central version 7 only once. All subsequent 
registration key updates will automatically occur via the Internet. To enter your Registration Key 
complete the following: 

1. Open Sportzware Central 
2. Click on ‘Help’ in the menu at the top of your screen and select Register 
3. Enter your registration name and registration code. 

 

 
 

4. Enter your Registration Code in the ‘Registration Code’ box.  
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5. Click on Finish 
6. You can check your registration status at any time by going to Help> Register from the 

Data Manager. 
 
Note: So long as your registration period is continuing, a new license key will be automatically 
downloaded via the Internet every 6 months. 
 
Network Key 
To enter your Network Key complete the following: 

1. Open Sportzware Central 
2. Go to the ‘Help’ menu at the top of your screen 
3. Select Register 
4. Enter your Registration Name in the ‘Registration Name’ boz. 
5. Enter your Registration Code in the ‘Registration Code’ box. 
6. Enter your Network Code in the ‘Network Code’ box. 

 
Note: If you would like to operate Sportzware Central across a local area network, please contact 
support at support@sportingpulse.com to request a network enabled code. 
 
1.5  Creating a New Database 
 
If you do not want to upload an existing database, you can create a new Sportzware Central 
database at any time through the Data Manager. This function allows you to create a new blank 
database. 

1. Open Sportzware Central from your desktop 
2. From the Data Manager screen, click on File 
3. Hover the mouse cursor over Add location and select Make New Database 
4. Click on New Folder 

 

mailto:support@sportingpulse.com
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5. Enter the name of the new database  
 

  
 

6. Click on OK 
7. The Edit Location screen will appear, allowing you to change the database name if 

required. Click on OK 
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8. The new database will appear in the Data Manager 
9. Click OK 
10. To open the new database, click on it from the Data Manager screen and click on the 

‘Launch’ button 
 
1.6  Navigation Centre 
 
The Navigation Centre is where the majority of your processes will take place. It is the focal point 
of the program, taking all of the most common processes and organising them within logical 
modules. There are some additional functions in Sportzware Central that you cannot access 
through the Navigation Centre, for example Career Statistics, Club Championship administration, 
and the ‘Delete a Round’ function. These can be accessed through the top menu. 
 

 
 

1. Drop down menu items provide the user with access to additional functions from any 
screen within the database. 

2. The Configuration module is where all program settings are generally located. 
3. The Membership module is where club, team and member information is managed 

(including transfers and tribunal). 
4. The Competitions module is where draws and scheduling is handled. 
5. Daily Admin is where season information such as results, statistics and ladders are all 

managed. 
6. Season Rollover helps the user with management of historical data. 
7. The Help button opens up a PDF copy of the SWC User Guide in Acrobat Reader. 
8. The Reports button takes the user to the Reports Centre where all reports are accessed 

from. 
9. Upload to the Web is where the user can (1) send competition information to their 

Sportzware Website, (2) synchronise membership information to their Sportzware Online 
Membership Database and (3) synchronise Online Results information. The Exit button 
closes the current database and returns you to the Data Manager screen. 

 
Most of the important functions in the Configuration module are handled in the Sportzware 
Central Startup Wizard, so for now we will skip to the Membership module and begin entering 
data. 

http://support.sportingpulse.com/index.php/Sportzware_Central_-_Configuration
http://support.sportingpulse.com/index.php/Sportzware_Central_-_Membership
http://support.sportingpulse.com/index.php/Sportzware_Central_-_Competitions
http://support.sportingpulse.com/index.php/Sportzware_Central_-_Daily_Admin
http://support.sportingpulse.com/index.php/Sportzware_Central_-_Season_Rollover
http://support.sportingpulse.com/index.php/Sportzware_Central_-_Reports
http://support.sportingpulse.com/index.php/Sportzware_Central_-_Competition_Upload
http://support.sportingpulse.com/index.php/Sportzware_Central_-_Competition_Upload
http://support.sportingpulse.com/index.php/Sportzware_Central_-_Membership_Synchronisation
http://support.sportingpulse.com/index.php/Sportzware_Central_-_Membership_Synchronisation
http://support.sportingpulse.com/index.php/Sportzware_Central_-_Online_Results_Synchronisation
http://support.sportingpulse.com/index.php/Data_Manager
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Part 1 (Chapter 2): Membership 
 
1.7  Clubs 
 
A club is representation of a number of teams that generally play within a league across multiple 
competitions/divisions. 
 
Search for a Club 

1. From the Navigation Centre click on the Membership Module. 
2. Click on Clubs 
3. Type the name of the club you wish to search for in the search box. As you type the list of 

clubs will be filtered to show the clubs beginning with the letters you have typed. You can 
filter the clubs by the league they belong to by selecting the league from the drop down 
box next to the search box 

 
Add a New Club 

1. From the Membership module, click on Clubs. 
2. Click Add to bring up the Club Administration window for a new Club. 
3. Enter the information you want to save for the Club. Note: The ‘Name’ field is the only 

compulsory field 
4. Click OK to save the information you have entered, or click Cancel to close the window 

without saving. 
 
Edit an Existing Club 

1. From the Membership module, click on Clubs. 
2. From the Club Administration window select the Club you wish to edit. 
3. Click Edit to edit the Club you have selected. 
4. Update the fields you wish to change and click OK to save the information you have 

entered, or click Cancel to close the window without saving. 
 
Delete a Club 

1. From the Membership module, click on Clubs. 
2. From the Club Administration window select the Club you wish to delete. 
3. Click Delete to remove the selected Club 
4. You will be asked if you are sure that you want to delete the Club. Click Yes to confirm or 

No to cancel. 
 
1.8 Teams 
 
A team is a body of players that belongs to a club and competes in a competition against other 
teams. 
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From the Competition or Teams tab, click on Teams to open the main Team Administration 
screen, which provides a list of all teams in the database. 
 
Add a New Team 

1. From the Membership tab, click on Teams. 
2. Select the competition that you want to add the new team to from the drop down list.  
3. Select All Teams if you do not want to add the team directly into an existing competition. 

Note: you cannot add a team to a 'current' competition (i.e. a competition that already has 
a fixture drawn up) from this screen. See Add a Team to a Current Competition for 
 details on how to do this. 

4. Click Add to bring up the Team Administration window for entering team details. 
5. Add the team information that you want to save. 
6. Click Ok to save the team, or Ok+ to save the team and add another team, or Cancel to 

close the window without saving. 
7. If the Add button is grayed out, the competition is already full. You will have to delete 

teams from this competition or increase the allowed number of teams in the competition. 
 
Edit Team Information 

1. From the Membership or Competitions tab, click on Teams 
2. Find the team that you want to edit. 
3. Click on Edit to bring up the Team Administration window for entering team details. 

 
Note: On the left is a series of tabs containing groups of specific team information. 
 

 
 
Delete a Team 

1. Find the team that you want to delete 
2. Click on Delete to delete the team from the database. 
3. You will be asked if you are sure that you want to delete the Team. Click on Yes to 

confirm or No to cancel. 
 

http://support.sportingpulse.com/index.php/Add_a_Team_to_a_Current_Competition
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Add Existing Teams to a Competition 
Normal Competition 
 

 
 

1. Click on the Insert button to add existing teams from your database into the competition. 
2. Click on Generate to create the draw. 

 
Knockout Competition 
Teams: 
 

 
 

1. Click on the Insert button to add existing teams from your database into the competition. 
2. Click on Generate to create the draw. 
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Players: 
 

 
 

1. Click on the Insert button to add existing teams from your database into the competition. 
2. Click on Generate to create the draw. 

 
Round Robin Competition (Pools) 
 

 
 

1. Click on the Insert button to add existing teams from your database into the competition. 
2. Click on Generate to create the draw. 
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Move Teams between Pools in a Round Robin Competition: 
 

1. From the competitions module click on Competition Details 
2. Select the Competition you want to modify pools/groups for and click Edit. You can use 

the Search fields at the top right to find the Competition you are looking for. 
3. Go to the Teams tab. 
4. Select the team you wish to move. 
5. Click on the Move button. 

 

 
 

6. Select the Group/Pool that you wish to move the selected team to.  
 

 
 

7. Click OK 
 
Add New Teams Directly into a Competition 
There are two ways to enter teams into competitions- from the competition administration in 
Competition Details or through the Team Administration area. 
 
Through the Competitions Details Area 
Normal Competition: 
 

1. Once you have added a normal competition, from the Competitions module go to 
Competition Details. 

2. Use the Search fields at the top right hand to find the Competition that you wish to add 
teams for. 
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3. Select the Competition. 
4. Click on the Teams tab 
5. Click on Add to bring up the ‘Team Administration’ window. 
6. Enter the information you want to record for the team. 
7. Click OK to save the information you have entered, or cancel to close the window 

without saving. 
 
Knockout Competition: 
 

1. Once you have added a knockout competition, from the Competitions module go to 
Competition Details. 

2. Use the Search fields at the top right to find the Competition that you wish to add teams 
for. 

3. Select the Competition 
4. Click on the Knockout tab 
5. Click on Add to bring up the ‘Team Administrator’ window 
6. Enter the information you want to record for the team. 
7. Click on OK to save the information you have entered, or Cancel to close the window 

without saving. The new team will be placed on the right hand side in the ‘Current first 
round matches’ section. 

 
Note: If you want to seed the team tick the Use Seeds option box at the top right hand side of the 
window and select a 'Seed Template' from the drop down box to the left of this field. The Seed 
numbers will appear in the 'Seed' column. Drag and drop the team onto the relevant position 
where their seed is. If a team is assigned a seed number, double clicking will place them in the 
appropriate seed position. 
 
Round Robin Competition: 
 

1. Once you have added a round robin competition, from the Competitions module go to 
Competition Details. 

2. Use the Search fields at the top right to find the Competition that you wish to add teams 
for. 

3. Select the Competition and click on Edit. 
4. Click on the Teams tab. 
5. Click on Add to bring up the 'Team Administration' window. 
6. Enter the information you want to record for this team. 
7. Click on Ok to save the information you have entered, or cancel to close the window 

without saving. 
8. Once you have added all the teams required for the competition you must then assign 

them to their pools. To do this click on Assign. 
 
Archive a Team 

1. From the Membership tab, click on Teams 
2. You cannot archive teams in current competitions. From the drop down list at top of 

screen, select Teams not in Current Competitions or Teams in Current/Historical 
Competitions. 

 

http://support.sportingpulse.com/index.php/Sportzware_Central_-_Competition_Details
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3. The list of teams able to be archived will be shown. Select the team that you want to 
archive. 

4. Click the Archive button.  
5. You will be asked if you are sure you want to archive the selected team. Click Yes to 

proceed or No to cancel. 
 
Unarchive a Team 

1. From the Membership tab, click on Teams 
2. Check the Historical button in the Team Filter to view all archived teams 

 

 
 

3. Select the archived team that you want to unarchive and click on Unarchive.  
4. You will be asked if you are sure want to unarchive the selected team. Click Yes to 

proceed or No to cancel. 
5. Click Close to return to the team administration window. 

 
1.9  Members 
 
Members are the people that make up the whole organisation; these are the 
association/club/team officials, coaches and players and anyone else who plays some role in the 
organisation. 
 
Note: In Version 7 of the program the MAI screen is a summary of what positions the member 
has held in the association. To add a member type to a member you need to click on the 
#Seasons tab. 
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Search for a Member 

1. From the Membership tab, click on Members. 
2. Click on the column title of the attribute you want to search by (e.g. surname, club name). 
3. Select the type of search you would like. A locate search will keep the entire list and 

search for the value you type. A filter search will reduce the list based on what you type. 
Extra filter options to control how the filter is applied are available. 

 
Add a New Member 

1. From the Membership tab click on Members. 
2. Click on Add to bring up the Member Administration window. 
3. Enter the details that you want to record for the member. 
4. Click OK to save the information you have entered, or Cancel to close the window 

without saving any changes.   
 
Edit an Existing Member 

1. From the Membership tab, click on Members. 
2. Find the member that you wish to edit. 
3. Click on Edit to open the Member Administration window for that member. 

 

 
 

4. Change the details as needed for the member. 
5. Click on OK to save the information you have entered, or Cancel to close the window 

without saving any changes. 
 
Delete a Member 

1. From the Membership tab, click on Members. 
2. Find the member that you wish to edit 
3. Click on Delete to delete the member from the database. 
4. You will be asked if you are sure that you want to delete a Member, click Yes to confirm 

or No to cancel. 
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Take a Photo 
1. From the Membership tab, click on Members. 
2. Find the member whose photo you wish to take. 
3. Click Photo 
4. You will be asked if you are sure that you want to take a photo of the selected member, 

click yes to continue or cancel to go back. 
5. Select the peripheral device that you wish to use to take a photo by clicking Select. 
6. The ‘Twain’ dialog box of our scanner/camera will be presented and you may then take 

the picture. 
7. Exit the dialog box and the photo should be returned to Sportzware Central where you 

can confirm to reject it. 
 
Print an ID card 

1. From the Membership tab, click on Members 
2. Select the member/s you want to print ID cards for. 
3. Click on ID card to view a report with ID cards for all selected members. 
4. Select the printer you want to print the ID card on and click OK. After the report appears 

on the screen, click the Printer button to send the report to the printer. 
 
Add Member to Mailing List 

1. From the Membership tab, click on Members. 
2. Find the member that you wish to add to the mailing list. 
3. Right click on the member and select Add to Mailing List 
4. You will be asked if you are sure you want to add the selected member to the mailing list. 

Click Yes to continue, and or No to cancel. 
 
Delete Member from Mailing List 

1. From the Membership tab, click on Members. 
2. Find the member that you wish to remove from the mailing list 
3. Right click on the member and select Remove from Mailing List. 
4. You will be asked if you are sure you want to remove the selected member from the 

mailing list. 
5. Click Yes to continue and No to cancel. 

 
Export Member List 

1. From the Membership tab, click on Members 
2. Right click on the member grid (any member will do); select Export and then select the 

type of file that you want to export to. 
3. Select where you want the file to be saved. 

 
1.10 Tribunal 
 
The Tribunal administration area is where an association can manage incidents where the laws of 
their sport have been breached (E.g. striking, verbal abuse, red and yellow cards). As well as 
keeping a record of a player's disciplinary history, Sportzware Central is able to prevent 
suspended players from being added to matches for the duration of their suspension. 
 
View & Sort Information 

1. From the Membership tab on the Navigation Centre, click on Tribunal. 
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2. The Tribunal Administration screen will open, which shows a list of all recorded offences. 
 

 
 

3. This screen allows you to sort offences by clicking on a column header and group 
offences by dragging and dropping the heading into the dark blue grouping area at the 
top of the list. 

 
Offences can be filtered by; 

 Send Offs 

 Guilty or Automatic 

 Penalty expiry date has passed 

 Charge date in last 7 days 

 Charge date in last 30 days 

 Hearing date today 
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Or grouped by any column heading; 

 Player Name 

 Offence 

 Outcome 

 Penalty 

 Penalty Type 

 Penalty Expiry Date 

 Charge Date  

 Hearing Date  
 

 
 

 
 
Manage Offences 
The Tribunal Administration screen is also where offences can be added, edited and deleted 
using the ‘Edit’, ‘Add’ and ‘Delete’ buttons. Offences can be added from two locations – the 
Tribunal area or the Full Match Entry Area. 
 
Add a New Tribunal Appearance/Offence from the Tribunal Area 
 

1. From the Membership tab click on Tribunal. 
2. Click on Add, this will open a new window with a list of players. 
3. Find and select the player who is incurring the offence. Click OK. 
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4. A new Tribunal Appearance Administration screen will open for the player. 
 

 
 

5. Select the Charge. Charges can be edited and new charges created by clicking on the 
Add/Edit icon. 

6. Select the competition 
7. Select the team 

8. Click the  icon to select the match date (all matches for that team will be available to 
pick from). This will auto-fill the match details, date and time.  

9. For offences where there will be a tribunal hearing, enter the date, time and venue for the 
hearing. If no hearing is required, click on ‘No Hearing’.  

10. Select the result from the drop down list.  
11. Enter suspended penalty information if applicable. 

12. Click Ok to save the information, or Cancel to close the window without saving. 
 
Note: When adding a tribunal appearance/offence from Full Match Entry the 'Player', 
'Competition', 'Team' and 'Match' fields are automatically entered. 

http://support.sportingpulse.com/index.php/Sportzware_Central_-_Full_Match_Entry
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Add an Offense (through Full Match Entry) 
 
Offenses can also be added through the Full Match Entry area. Using this point of entry will 
automatically populate all of the Match Details fields. 
 

 
 

1. Open a match 
2. Click on the tab of the team with the offending player 
3. Ensure the player is entered into the game (use the Register/Add button to move them 

from left to right) 
4. Right click on the player and select ‘Send Off’ or ‘Reported Offence’ 

 

 
 
Note: A new Tribunal Administration screen for that player opens, with the match details already 
populated. These cannot be changed. 
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5. Fill in the details as per steps 5-12 under ‘Add a New Tribunal Appearance/Offence’ 
above. You can bypass steps 6-8 as these are pre-populated. 

 
Edit an Existing Tribunal Appearance/ Offence 

1. From the Membership tab click on Tribunal. 
2. Find the tribunal appearance/offence you wish to edit by using the search fields at the top 

right of the screen. 
3. Select the tribunal appearance/offence you want to edit. 
4. Click on Edit to bring up the 'Tribunal Appearance Administration' window for that tribunal 

appearance/offence. 
 

 
 

5. Make the necessary changes to the tribunal appearance/offence. 
6. Click OK to save the information, or Cancel to close the window without saving. 

 
Delete a Tribunal Appearance/Offence 

1. From the Membership tab click on Tribunal. 
2. Find the tribunal appearance/offence you wish to delete by using the search fields at the 

top right hand side of the screen. 
3. Select the tribunal appearance/offence you wish to delete. 
4. Click Delete. 
5. You will be asked if you are sure that you want to delete the tribunal appearance/offence. 

Click Yes to confirm or No to cancel. 
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Manage Offence Types 
Offence names, codes and outcomes (E.g. fine costs or number of weeks of suspension) can be 
edited through the Offences Types admin area. This area is accessed through the Add/Edit 
button next to ‘Charge’ on the Tribunal Administration screen. 
 

 
 
The list of offence types will appear. 
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From this screen you can add, edit or delete offence types using the buttons at the top of screen. 
 
Add/Edit an Offence Type 
 

1. To add a new offence type, click on ‘Add’. 
2. To edit an existing offence, select an offence from the list and click on ‘Edit’. 

 

 
 

3. Enter the information relating to the offence; 

 Name 

 Abbreviation 

 Penalty information- type of penalty (either a number of matches, points, weeks 
or fine) and the number of matches, points, weeks or fine amount). 

 When this offence is given to a player, it will automatically populate the outcome 
with the penalty (1 Match). 
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Suspensions 
 
When the outcome of an offence is a suspension, the expiry date for the suspension must be 
selected. 
 

 
 
When you attempt to add a suspended player to a match, you will be prevented from doing so. 
This applies to both Sportzware Central and the Online Results module. 
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1.11 Email Centre 
 
The Email Centre allows you to email members who have email addresses in their record. To be 
able to send emails from Sportzware Central, the correct outgoing mail server settings must be 
entered and the computer must be on a network that allows the sending of email from third party 
software. Alternatively, rather than use an outgoing mail server, you can select a setting to send 
email through Microsoft Outlook or Outlook Express. 
 
Compose an Email 

1. From the Membership tab, click on Email Centre. 
2. Click on Compose to bring up the ‘Select Members fro Group Email’ screen. 
3. Select the group from the drop down list from where you wish to select the members to 

email. 
4. Select the members you wish to send an email. If you wish to email all members in the 

group, right click the mouse on the grid and click on Select All. 
5. Click on the Add Members to Email List and then click on the OK button. 
6. The ‘Message Editor’ screen will now appear. 
7. Enter in the contents of your email and then click the Send button. 

 
Archive Email 

1. From the Membership tab, click on Email Centre. 
2. Select an email message from one of the three tabs (Outbox, Sent Items and Draft) and 

click on the Archive button. 
3. The message will be sent to the archive. 

 
1.12 Importing Members through Excel Spreadsheet 

 
Below is the link, to view the video which explains the process for importing members through 
Excel Spreadsheet. 
 
http://support.sportingpulse.com/index.php/Importing_Members_Through_Excel_Spreadsheet 
 
 

http://support.sportingpulse.com/index.php/Importing_Members_Through_Excel_Spreadsheet
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Part 1 (Chapter 3): Competitions 
 
1.13 Competition Details 
 
Sportzware Central allows an organisation to create and manage its competitions. Sportzware 
Central caters for three different competition formats- normal, knockout and round robin 
(pools/groups). 
 
Below is a link to the video which runs through the first phase of setting up a normal competition 
from scratch. 
 
http://link.brightcove.com/services/player/bcpid30740774001?bctid=31742612001 
 
1.14 Venues 
 
All matches in a competition draw need to be assigned to venues (courts, fields, ovals, etc). 
Before adding a new competition and generating a fixture, you should ensure that all venues to 
be used in the competition have been added to the database. 
 

 
 
From the Competitions tab, click on Venues to open the Venue Administration screen, which 
provides a list of all venues in the database; 

 Add a New Venue 

 Edit Venue Information 

 Upload Venue Information to Web 
 
Add a Venue 
Before setting up your competitions, it is recommended that you add your match venues first.   
 

1. From the Navigation Centre, go to the Competitions module. 
2. From the Competitions tab, click on Venues. The Venue Administration window will 

appear. Click Add. 
3. A blank ‘Venue Details’ window will open. Enter the information you want to record for the 

Venue.  
 

http://link.brightcove.com/services/player/bcpid30740774001?bctid=31742612001
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Note: The ‘Name’ and ‘Abbreviation’ fields are compulsory. 
 

4. Click on OK to save the information you have entered, or click cancel to close the window 
without saving. 

 
Edit Venue Information 

1. From the Competitions tab, click on Venues. 
2. Locate and select the venue you want to edit (you can use the column header search 

filter at top of screen if desired). 
3. Click on Edit to bring up the Venue Details window for the selected venue. 

 

 
 
On the left is a series of tabs containing groups of specific venue information. 

 General 

 Times 

 Officials 

 Matches 

 Subvenues 

 Notes 
 
Subvenues can be used to split the one Venue into multiple Venues (for junior games) so in 
some cases a field might be split up into Smith Park Field 1, Smith Park Field 2, etc. 
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1.15 Fixture Generation 
 
A fixture, also known as a draw or schedule, is a timetable of matches showing competitors, 
rounds, match times, dates and venues. 
 
Generate a New Fixture 
The Fixture Generation step can be reached in two ways. 
 
Note: you must first have created a Competition and added its Teams before you can Generate a 
fixture. 

 
Proceeding through the Competition Setup Wizard, or by clicking on Fixture Generation from 
the Competitions tab: 

1. From the Fixture Generation window, select a competition and click Select. 
 

 
 

2. Enter the venue and date requirements for the fixture. 
3. Click on OK to generate the fixture. 
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Venue Allocation 

 
 

1. If you have selected ‘Court Allocation’ as the venue option from the Fixture 
Generation screen, the Court/Venue Allocations screen will open after clicking on 
OK.  

2. From here you can select the venues and times that will be used for the 
competition. 

3. Click on OK to generate the fixture. 
 
1.16 Edit Fixture 
 
The ‘Edit Fixture’ function allows you to edit an existing fixture by altering information for existing 
games as well as adding and removing games to the competition. 
 
Edit Matches within a Fixture 

1. From the Competitions tab, click on Edit Fixture. 
2. From the ‘Pick a Competition’ window, select a competition and click on Select. 
3. Select a match that you want to change and click on Select. 
4. Click on the fields that you want to update and change the information as required. 

 

 
 

5. Click OK to save the changes, or Cancel to close the window without saving. 
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Add a New Match within a Fixture 
1. From the Competitions tab, click on Edit Fixture. 
2. From the ‘Pick a Competition’ window, select a competition and click Select. 
3. Select the match that you want to change and click Select. 
4. Click on Add a Game in the bottom left corner. 

 

 
 

5. Add the information for the match. Click OK to save the match or Cancel to close the 
window without saving. 

 
Delete a Match within a Fixture 

1. From the Competitons tab, click on Edit Fixture 
2. From the ‘Pick a Competition’ window, select a competion and click Select. 
3. Select the match that you want to delete and click on Select. 
4. Select a match that you want to delete and click Remove a Game 
5. Click OK to save the changes or Cancel to close the window without saving. 

 
Add a Round to a Fixture 

1. Click on Competition Setup in the top menu. 
2. Select Fixtures and click Add a Round 

 

 
 

3. Select the competiton that you want to add a new round to and click Select. 
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4. Select the round that you want toa dd the new round after, and then click OK. 
5. Select the date for this round then click OK. 
6. Insert the matches (see ‘Add a New Match within a Fixture’ above), and their times and 

venues. 
 
Delete a Round from a Fixture 

1. Click on Competiton Setup in the top menu. 
2. Select Fixtures and click on Delete a Round 

 

 
 

3. Select a competiton from the competitions list and click on Select. 
4. Select the round that you want to delete and click OK. 

 
1.17 Fixture Grid 
 
Allocate Match Officials 
To allocate match officials you must first ensure that all individual match officials are added as 
members in the database and also specified as being match officials in the Membership Details 
form of their membership administration screen in the membership tab. 
 
To allocate teams or clubs as match officials you must tick the Use Teams as Match Officials and 
Use Clubs as Match Officials boxes in the Preferences window in the Configuration tab. 
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1. From the Competitions tab, click Fixure Grid. 
2. Select the date that you wish to allocate match officials to. 
3. Select Match Officials from the Allocation drop down menu at the top of the window. 
4. Select the date that you wish to assign Match Officials for from the calendar on the left 

hand side. 
5. All the matches will appear for the day in the Fixture Grid. Drag the Match Officials from 

the left hand side onto the matches that you want to assign them for. 
6. Click OK to save the information you have entered or click Cancel to close the window 

without saving. 
 
Print Matches for a Specific day 

1. From the Competions tab, click Fixture Grid. 
2. Select the date that you wish to view matches for from the calendar on the left hand side. 
3. Right click any of the matches on the Fixture Grid and select Print Fixture Grid. 
4. Change the Print Settings to display the report as you wish. 
5. Click OK to preview the report. 
6. Click the Printer icon at the top of the window to send the Fixture Grid report to the 

printer. 
 
Export Daily Matches 

1. From the Competitions tab, click on Fixture Grid. 
2. Select the date that you wish to export matches for. 
3. From the File menu at the top of the screen select Export and then the desired format 

(Excel, Word or HTML). The matches will be exported to the selected format where you 
can make any manual changes you like from there. 
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Resolve Clashes 
Clashes can also be resolved in the Clash Resolution section of the Competitions tab. 
 

 
 

1. From the Competitions tab, click Fixture Grid. 
2. Select the date that you wish to resolve the clashes for. 
3. Any clashes that exist in the fixture will appear in pink 
4. To resolve the clashes drag the cell into an empty cell in the fixture grid 
5. Click apply to apply these changes to the fixture 

 
1.18 Generate Finals Fixtures 
 
Finals are the latter phase of a season where the number of competitors in a competition is 
usually reduced to playoff for the final positions. 
 
Below is a link to the video that explains how you can generate your finals fixtures in the 
Sportzware Central program. 
 
http://link.brightcove.com/services/player/bcpid30740774001?bctid=31703184001 
 
1.19 Clash Resolution 
 
Clash Resolution is the process of working through clashes (matches being played at the same 
venue at the same time) of an existing fixture and resolving them by allocating new venues or 
changing the time of the match. Clashes can also be resolved by using the Fixture Grid. 
 

 

http://link.brightcove.com/services/player/bcpid30740774001?bctid=31703184001


 Touch Football Australia Sportzware User Manual Page 36 of 44 

Start from Today 
1. From the Competitions module select Clash Resolution 
2. Select Start from today (this will show all clashes form today onwards). 
3. Select the game that you want to move 
4. Change either the date of the game, start time or venue 
5. If this new time slot is available the resolve clash button will be activated. Click this 

button to resolve the clash. 
6. Continue through until all clashes are resolved or hit close to exit the Clash Resolution 

screen. 
 
Select Start Date 

1. From the Competitions module select Clash Resolution 
2. Select Select Start Date (this will show all clashes from the specified date). 
3. Select the game that you want to move 
4. Change either the date of the game, start time or venue 
5. If this new time slot is available the resolve clash button will be activated. Click this 

button to resolve the clash. 
6. Continue through until all clashes are resolved or hit close to exit the Clash Resolution 

screen. 
 
Show all Clashes 

1. From the Competitions module select Clash Resolution 
2. Select Show all clashes (this will show all clashes). 
3. Select the game that you want to move 
4. Change either the date of the game, start time or venue 
5. If this new time slot is available the resolve clash button will be activated. Click this 

button to resolve the clash. 
6. Continue through until all clashes are resolved or hit close to exit the Clash Resolution 

screen. 
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Part 1 (Chapter 4): Daily Admin 
 
Daily Admin is where an organisation will perform most of its day to day operations- entering 
match scores, statistics, managing ladders, match officials, etc. 
 

 
 
The 8 functions in Daily Admin screen are: 

 Full Match Entry - enter results, player and team statistics, votes and other match related 
information. 

 Quick Entry by Date - provides interface for quick entry of match scores only for a given 
date. 

 Finals Match Results - enter full match results, including team and player statistics, for 
Finals Matches. 

 Match Official Allocation - allocate match officials to matches.  

 Match Official Maintenance | Match Official Pay - enter and edit Match Official details. Set 
up Match Official pay rates. 

 Ladders | Ladder Design - a ladder is the standings of teams within a competition. Ladder 
fields and rules can be defined in 'Ladder Design'. 

 Statistics - view player statistics by competition, career, round and team. 

 Voting - allocate match votes to players. 
 
1.20 Full Match Entry 
 
This is where you can enter all the match scores and a detailed array of statistics for a 
competition. 
 
Enter Match Scores and Statistics 

1. From the Daily Admin module click Full Match Entry. 
 

http://support.sportingpulse.com/index.php/Sportzware_Central_-_Full_Match_Entry
http://support.sportingpulse.com/index.php/Sportzware_Central_-_Quick_Entry_By_Date
http://support.sportingpulse.com/index.php/Sportzware_Central_-_Finals_Match_Results
http://support.sportingpulse.com/index.php/Sportzware_Central_-_Match_Official_Allocation
http://support.sportingpulse.com/index.php/Sportzware_Central_-_Match_Official_Maintenance
http://support.sportingpulse.com/index.php/Sportzware_Central_-_Match_Official_Payments
http://support.sportingpulse.com/index.php/Sportzware_Central_-_Ladders
http://support.sportingpulse.com/index.php/Sportzware_Central_-_Ladder_Design
http://support.sportingpulse.com/index.php/Sportzware_Central_-_Statistics
http://support.sportingpulse.com/index.php/Sportzware_Central_-_Voting
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2. The ‘Entering Match Results’ screen will open. Select a competition and click Select. 
 
Note: If there are no competitions appearing on the screen use the Seasons filter at the top of the 
screen. 
 

3. The list of matches will appear for that competition. Click on the match you want to enter 
results and statistics for and click OK. 

 

 
 
The ‘Full Match Entry’ screen for that match will open. Please note that the score entry screen 
varies from sport to sport. The nine tabs down the left hand side provide input for various match 
information.  
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4. Enter match information and click OK to save. 
 
1.21 Quick Entry by Date 
 
This screen allows you to enter match results quickly without having to enter any statistics or 
other detailed match information. 

1. From the Sportzware Central- Daily Admin tab click Quick Entry by Date 
 

 
 

2. Select the date of the match you would like to enter then click OK. 
3. Enter results underneath the score section for each team. 
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4. If you would like to enter more Quick Entry By Date results they can be selected by date 
from the drop down box. 

5. Once you have finished entering results click OK. 
 
1.22 Match Official Pay 
 
A Match Official is a person who adjudicates, or oversees the running of a match. 
 
Note: Match Official payments will be calculated based on values entered in this window as 
Match officials are added to Matches.  
 
These are only the default payments, and they can be changed independently for each Match. 
 
Add a Payment to a Match Official 

1. To add a payment value to a match official type click on Daily Admin then click on the 
Match Official Pay button. 

2. In the screen that opens, you can Add a Payment to Match Official by Grade, Add a 
Payment to Match Official by Type and Add/Edit a Match Official Type. 
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Part 1 (Chapter 5): Season Rollover 
 
The Season Rollover module is where you can organise your competitions into an archive. 
 
1.23 Archive/Unarchive Competitions 
 

1. From the Season Rollover tab, click on Archive Competitions 
2. Move the Competitions that you wish to archive to the ‘Competitions to be Archived’ box 

on the right hand side using the <> arrows. 
3. Click OK to archive the competitions selected, or Cancel to close the window without 

archiving. 
 
 
Part 1 (Chapter 6): Reports Centre 
 
The Reports are the output of information that is used to summarise certain aspects of the 
information in the database. Some common reports include fixtures/schedules, scoresheets, 
match summary reports etc. 
 
1.24 Preview a Report 
 

1. Click on the Reports button located on the right-hand side of the Navigation Centre to 
bring up the Reports module. 

2. Scan through the tabs at the top of the window to find the report you would like to 
preview. 

3. Click on Preview to display a report’s content on the screen. 
 

 
 
1.25 Export a Report 
 
Exporting sends information from Sportzware Central to a different program in a format specific to 
that program E.g. Microsoft Word, Excel etc. This is typically done when the user wishes to make 
formatting changes to the information before printing. 

1. Click on the Reports button located on the right-hand side of the Navigation Centre to 
bring up the Reports module. 

2. Scan through the tabs at the top of the window to find the report you would like to 
preview. 

3. Click on Export to bring up the export options for the chosen report. 
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After choosing the parameters for your report you will need to choose a format and a destination 
for the report. ‘Format’ refers to the type of application you wish to view the report in. 
 
 

Part 1 (Chapter 7): Upload to the Web 
 
1.26 Competition Upload 
 
Below is the link to a video that runs through the complete process involved in uploading your 
competition information to the website. 
 
http://link.brightcove.com/services/player/bcpid30740774001?bctid=33234144001 
 
The Member Data Sync- IMPORTANT INFORMATION 
 
Note: Before performing your first membership synchronisation, you must; 
 

1. Click on this link - Synchronising Membership Data - and carefully read the instructions 
provided, and 

2. Enter your Membership Synchronisation code into SWC. 
 
1.27 The Membership Synchronisation 
 
In order to synchronise membership data you must be connected to the Internet. 
 

1. Open Sportzware Central 
2. Launch a database from the Data Manager 
3. From the Navigation Centre click on the Upload to Web button 

 

 

http://link.brightcove.com/services/player/bcpid30740774001?bctid=33234144001
http://support.sportingpulse.com/index.php/Synchronising_Membership_Data
http://support.sportingpulse.com/index.php/Enter_your_Membership_Synchronisation_code
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If you have more than one Uploader Profile you will see a screen asking whether you wish to 
perform a 'Competition Upload', 'Membership Synchronisation' or 'Online Results 
Synchronisation'. 
 

4. Select Membership Synchronisation and then click on Ok. 
 
If you don't see the Uploader Profile screen, it will take you directly to the one Uploader Profile 
you currently have set as active. If this isn't the Membership Synchronisation profile, it means you 
haven't got your Membership Synchronisation activated. Go to the Uploader Configuration area to 
activate it. 
 

 
 

5. Click on Synchronise. This will update your membership data in both your Sportzware 
Central database and online membership database.  

 
The speed of the competition upload will vary depending on the number of members in your 
database. The very first synchronisation performed may take several hours. Subsequent 
synchronisations tend to take between 1 - 10 minutes. 
 
1.28 Online Results Synchronisation 
 
To add a new fixture to Online Results 

1. The Association performs a Membership Synchronisation 
2. The Association performs a Competition Upload 

 
The fixture/s will now appear in the Online Results module. Clubs/ teams are able to submit their 
results by going to the fixture on the association website, and clicking on the 'Enter Results' link 
corresponding to their match. The association must provide the club/ team with their login code. 
 
To publish results to the website 

1. Clubs/ Teams enter results and other match details into Online Results 
2. The association performs an 'Online Results synchronisation' from Sportzware Central to 

download all match scores into their Sportzware Central database (see steps below) 
3. The association can review/ verify the details and make any corrections if needed. They 

then perform a Competition Upload to update all results and other game details on the 
web. 

 
To perform an Online Results synchronisation 

1. Launch Sportzware Central 
2. Click on the Upload to SportingPulse button 
3. The Uploader Profile screen will open. Select Online Results Synchronisation and click 

on OK 
4. Click on the Synchronisation button 

http://support.sportingpulse.com/index.php/Sportzware_Central_-_Uploader_Configuration
http://support.sportingpulse.com/index.php/Sportzware_Online_Membership
http://support.sportingpulse.com/index.php/Sportzware_Central_-_Competition_Upload
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Conclusion 
 
After completion of Part 1 of this manual, you should now be ready to install and start using 
Sportzware Central and its various components.   In summary, Part 1 covered:  
 
Part 1 (Chapter 1): Introduction to Sportzware Central- Installation and creating your 
database, Startup Wizard, Data Manager, Registration, Creating a new database, Navigation 
Centre 
 
Part 1 (Chapter 2): Membership- Clubs, Teams, Members, Tribunal, Email Centre, Importing 
Members through Excel Spreadsheet 
 
Part 1 (Chapter 3): Competitions- Competition Details, Venues, Fixture Generation, Edit 
Fixture, Fixture Grid, Generate Finals Fixtures, Clash Resolution 
 
Part 1 (Chapter 4): Daily Admin- Full Match Entry, Quick Entry By Date, Match Official Pay 
 
Part 1 (Chapter 5): Season Rollover- Archive/Unarchive Competitions 
 
Part 1 (Chapter 6): Reports Centre- Preview a Report, Export a Report 
 
Part 1 (Chapter 7): Upload to the Web- Competition Upload,  Online Results Syncronisation 
 
 
If you are have any further queries about these steps, please read back through the exercises. 
 
  
 


